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01. INSTALAÇÃO E DESINSTALAÇÃO DO SOFTWARE 01. INSTALAÇÃO E DESINSTALAÇÃO DO SOFTWARE

ETAPAS BÁSICAS DE INSTALAÇÃO CONFIGURAÇÃO DE SOFTWARE

CONFIGURAÇÃO DE SOFTWARE

01 • Instalar o software Access Control.

02 • Clique "Next".

03 • Clique "Next".

04 • Clique "Next".

01 • Primeiramente coloca o CD no CD-ROM, depois executa a aplicação do "setup.exe" ou através do 
nosso websibe fazendo o download da pasta do software e executa a aplicação do "setup.exe", que está 
dentro da pasta do software.

Memória: 1 GB.
Disco Rigído: 1 GB acima de espaço livre.

• Windows 7
• Windows 10

REQUISITOS BÁSICOS PARA INSTALAÇÃO

OPERAÇÃO DE SISTEMA SUPORTADO PELO SOFTWARE
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05 • Clique "Close".
Após a conclusão da instalação, será criado           automaticamente e exibido na tela do computador.

01. INSTALLATION AND UNINSTALLATION OF SOFTWARE 01. INSTALLATION AND UNINSTALLATION OF SOFTWARE

CONFIGURAÇÃO DE SOFTWARE

REMOVER SOFTWARE

REMOVER SOFTWARE
01 • Clique "Iniciar" e digite "Painel de Controlo".
02• Clique "Remover programa".

03 • Encontre o software "Access Control", e clique "Remover".

04 • Clique "Sim".
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
INICIAR SESSÃO INICIAR SESSÃO
Clique ou             execute Iniciar> Programas> Access Control> Access Control, ele abrirá a janela de Login 

da seguinte maneira:

Utilizador: abc
Palavra-passe: 123
Recomenda-se alterar o nome de utilizador e palavra-passe após a primeira utilização.

Se a conexão do SQL Server falhar. Aparecerá a caixa de diálogo anterior.
01 • Clique em "Ok". Por favor, consulte o Apêndice Configuração do SQL Server.
Após o login, ele mostrará a janela principal, da seguinte maneira:

CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO
ADICIONAR/CONFIGURAR CONTROLADOR
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO
01 • Clique em Configuration > Controllers na barra de menus.
02 • Clique no botão "New" para adicionar os controladores ao sistema.

O número do controlador (é o número de série do controlador) pode verificar na etiqueta S / N: ********* 
do controlador. por favor preencha os nove números.

“Door Name” e “Reader Position” podem ser modificados.
04 • Marque "Active", a consola exibirá a porta, caso contrário, não será exibida.
05 • Marque "Attendance", para os registros no leitor de cartão poderem ser usados ​​como registros de 
presença, caso contrário, não serão.
06 • Clique"Ok".

03 • Clique "Next".

Se o controlador S / N que escreveu não é o mesmo que a etiqueta S / N: ********* o software 
não pode comunicar com o controlador.

Rede Pequena: Suporta comunicação TCP / IP, todos os controladores estão no mesmo 
segmento de rede.

Rede média ou grande ou Internet: Suporta comunicação TCP / IP para diferentes 
controladores de segmento de rede.
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO

ADICIONAR/CONFIGURAR IP

01 • Clique "Search".

03 • Clique"Ok".

Resultado, poderá ver o endereço IP.
04 • Clique  "Next".

Os controladores são separados em redes diferentes. Cada controlador deve receber um endereço IP 
exclusivo.

A pesquisa levará cerca de 5 segundos.
02 • Clique "Configure".

Após a configuração do endereço IP,  poderá definir os parâmetros do controlador, o endereço IP deve 
ser atribuído ao controlador correspondente.
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO

FILTRO IP GERENCIAR ZONA DO CONTROLADOR

Por segurança, e somente um computador ter acesso a este software e base de dados, clique com o 
botão direito do rato, e seleccione "IP Filter".

02 • Clique "Add Top" e escreva na área em branco.

03 • Clique "Ok".
Resultado, poderá ver a Zona criada.

Coloque o IP permitido e clique "Add Allowed IP" ou clique "Add Current PC IP".
01 • Clique  "Only Update IP List"

01 • Clique com o botão esquerdo do rato no controlador e depois clique "Zones".



9A 9B
PTPT

02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONFIGURAÇÕES DE PARÂMETRO DO EQUIPAMENTO OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO

04 • Clique  "Add Branch" para adicionar um novo local sob a zona.
05 • Escreva na área em branco e clique "Ok".
Resultado, poderá ver o local criado.

Feche essa janela.
05 • Defina a janela Zone no Controlador.

01 • Clique em Configuration > Department na barra de menus.
02 • Clique no botão "Add Top" para adicionar um departamento.
03 • Escreva na área em branco e clique "Ok".

ADICIONAR DEPARTAMENTO
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO
04 • Clique  "Add Branch" para adicionar um novo subdivisão sob o departamento.
05 • Escreva na área em branco e clique "Ok".
Resultado, poderá ver o local criado.

ADICIONAR E EDITAR UTILIZADOR

01 • Clique em Configuration > Personnel na barra de menus.
02 • Clique no botão "Add" para adicionar utilizadores.

03 • Escreva nas áreas "User ID" e "Name".
04 • Para adicionar foto ao utilizador clique "Photo" e escolha o ficheiro pretendido. 
05 • Depois de inserir a informação nesses campos do utilizador, clique em "Add Next", para a janela de 
apresentação continuar aberta e poder inserir informação de outro utilizador. 
Caso não queira adicionar mais utilizadores, clique "Ok" e o utilizador foi adicionado ao sistema.



11A 11B
PTPT

02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO
06 • Para poder editar o utilizador criado clique "Edit".
Poderá adicionar mais informação através do submenu "Others".

Resultado, poderá ver os cartões de registo.
04 • Clique "Ok" no final da operação, e os cartões de registo serão adicionados ao sistema.

ADICIONAR AUTOMATICAMENTE O CARTÃO DE REGISTO

01 • Clique em Configuration > Personnel> Auto Add na barra de menus.
02 • Se selecionar "USBReader", conecte o leitor de cartão USB (o modelo # para o produto wiegand é 
WG1028) com o computador.
03 • Clique "USB Reader" or "Controller", e de seguida clique "Next".
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO OPERAÇÃO DO DEPARTAMENTO E UTILIZADOR REGISTADO
05 • Se selecionar "Manual Batch Input", os cartões de registo serão adicionados manualmente.
06 • Clique "Manual Batch Input", e de seguida clique "Next".
07 • Escreva nas áreas "Start No." e "End No."
08 • Clique "Ok" no final da operação, e os cartões de registo serão adicionados ao sistema.
Resultado, poderá ver os cartões de registo. Todos os cartões registados automaticamente o nome por 
defeito é "N+ Número de Cartão".

PERDA DE CARTÃO • ACESSO DE PRIVILÉGIOS

Se alguém perder o seu cartão, é necessário registar o cartão perdido e depois redistribuir um novo 
cartão ao utilizador.
01 • Clique em Configuration > Personnel > Card Lost na barra de menus.

01 • Clique em Configuration > Access Privilege na barra de menus.
02 • Clique "Change Privileges".

02 • Escreva na área "New Card NO" o novo número do cartão, e de seguida clique "Ok".
Se o cartão de utilizador possuir algum privilégio, depois de reportar a perda do cartão, atualize o 
controlador.

OPERAÇÃO
GESTÃO DE PRIVILÉGIOS
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
OPERAÇÃO OPERAÇÃO

03 • ">>" Selecione todos os utilizadores ou todas as portas opcionais.
">" Selecione um utilizador ou uma porta opcional.
"<" Cancele um utillizador selecionado ou uma porta selecionada.
"<<" Cancele todos os utilizadores selecionados ou todas as portas selecionadas.

04 • Se clicar em "Allow", e de seguida Operation > Upload, os utilizadores selecionados podem passar 
pelas portas selecionadas.
Se clicar em "Allow and Upload", os utilizadores selecionados podem passar pelas portas selecionadas.
Se clicar em "Prohibit", e de seguida Operation > Upload, os utilizadores selecionados não podem passar 
pelas portas selecionadas.
Se clicar em "Prohibit and Upload", os utilizadores selecionados não podem passar pelas portas 
selecionadas.

05 • Depois de adcionar todos os privilégios no sistema,  clique em Operation > Upload para que atualize 
o controlador.

03 • Clique "Confirm and Upload" se adicionou portas opcionais ou cancelou portas selecionadas para 
atualizar o controlador e o utilizador possa passar pelas portas selecionadas.

• EDITAR O PRIVILÉGIO DE UM UTILIZADOR

01 • Selecione o utilizador e clique "Edit One User"
02 • ">>" Selecione todas as portas opcionais.

">" Selecione uma porta opcional.
"<" Cancele uma porta selecionada.
"<<" Cancele  todas as portas selecionadas.
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONSOLA CONSOLA
01 • Clique em Operation > Console na barra de menus.

INFORMAÇÃO DE CONTROLADOR
01 • Clique em Operation > Console > Check na barra de menus.
Resultado, apresenta a informação básica do controlador, como a quantidade de passagens de cartões  
e privilégios, estado da porta, estado do controlador, entre outros.  Se o controlador comunica bem com 
o computador, a cor da porta será verde, de outra forma será vermelha.

CONFIGURAR O UPLOAD

01 • Clique em Operation > Console > Upload na barra de menus.
02 • Clique "Ok".
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02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONSOLA CONSOLA

MONITOR RECEBER REGISTOS

CONSULTA DE REGISTOS

01 • Clique em Operation > Console > Download And Monitor na barra de menus. 01 • Clique em Operation > Console > Download na barra de menus. Colecta os registos do controlador 
para a base de dados.

Faça primeiro "Download" dos registos antes da consulta.
01 • Clique em Operation > Query Swipe Records na barra de menus. 

01 • Clique com o botão direito do rato, e seleccione "Display More Swipes". Apenas demonstra registos 
de passagem com cartão.

MOSTRAR MAIS REGISTOS
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Se quiser filtrar as entradas e saídas por "Addr", clique "Query Option".
02 • Clique "Query" para apresentar os registos pretendidos.

Pode alterar o nome e a palavra-passe do operador.
01 • Clique em Tools > Edit Operator na barra de menus. 

01 • Clique em File > DB Backup na barra de menus. 
02 • Clique "Ok".
Esta cópia de segurança é gravada no sistema pelo caminho "C:\AccessControl".
Caso a cópia de segurança seja SQL DB.  A cópia de segurança é gravada no sistema pelo caminho "C:\
Program Files\Microsoft SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Backup".

02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE
CONSOLA FUNCIONALIDADES

FUNCIONALIDADES
ALTERAR PALAVRA-PASSE

CÓPIA DE SEGURANÇA DE BASE DE DADOS

02 • Escreva nas áreas em branco e clique "Ok".
NOTA: A "New Passord" and "Confirm Password" tem de ser iguais. Depois de alterar a palavra-passe 
atual, reinicie o sistema, e faça o login novamente.
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OPÇÃO

02. OPERAÇÃO BÁSICA DO SOFTWARE 02. OPERAÇÃO BÁSICA DO SOFTWARE

03. FUNCIONALIDADES EXTENSAS

FUNCIONALIDADES

Pode alterar outra definições do sistema.
01 • Clique em Tools > Language na barra de menus para alterar o idioma.

Ao ativar as Funcionalidades Extensas, deve reiniciar o sistema.

02 • Clique "Interface Setting" na barra de submenus para alterar a interface.
House: Utilizado numa gestão comunitária.
Show Getting Started When Login: Para guiar o software de operação.

03 • Clique "Auto Login" na barra de submenus para ativar a função.
Não será mais necessário colocar "User Name" e "Password" para iniciar sessão no sistema.

FUNCIONALIDADES

01 • Clique em Tools > Extended Functions na barra de menus.
Insira a palavra-passe.
Palavra-passe: 5678
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03. FUNCIONALIDADES EXTENSAS03. FUNCIONALIDADES EXTENSAS
FICHEIRO CONFIGURAÇÃO

01 • Ative a opção "Active Log Query" para ativar a consulta de registos.

ATIVAR CONSULTA DE REGISTOS GRAVAR EVENTOS DE BOTÃO DE PRESSÃO

Grava cada vez que o botão de pressão é utilizado.
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03. FUNCIONALIDADES EXTENSAS03. FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

Deve conectar o sensor da porta. Regista o tempo de "Door Open" e "Door Closed".
NOTA: Após ativar qualquer função deve fazer "Upload" da consola.

ATIVAR PERFIL DE TEMPO

01 • Ative a opção "Activate Time Profile" e "Activate Time Seg Limitted Access".
02 • Clique em Configuration > Time Profile na barra de menus.

03 • Clique "New" para adicionar um novo perfil de tempo e as suas caracteristicas.
04 • Escreva nas áreas em branco e clique "Ok".

Resultado, ao adicionar um cartão de utilizador "Normal", tem permissão para trabalhar no perfil criado, 
podendo entrar e sair dentro do tempo definido.
Após definir os diversos perfis de tempo pretendidos, selecione as permissões correspondentes aos 
utilizadores no Acesso  de Privilégios.

GRAVAR EVENTOS DE ESTADO DA PORTA
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03. FUNCIONALIDADES EXTENSAS03. FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

ATIVAR CONTROLO PERIFÉRICO

01 • Ative a opção "Activate Peripheral Control", "Threate Code Valid After RegisgterCard Swipe" e Activate 
Open Too Long Wam".

02 • Clique em Configuration > Peripheral na barra de menus.

03 • "Threat Code" : deve ser utilizado com o leitor de cartão de teclado PIN.
04 • Clique "Hardware Configuration".

05 • Determine as configurações pretendidas.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

ATIVAR ACESSO AO TECLADO
01 • Ative a opção "Activate Access Keypad".

02 • Clique em Configuration > Pwd MGT na barra de menus.

03 • Determine as configurações pretendidas.
04 • Clique "Card+PIN", ou "PIN Code" ou "Controller's Password" ou "Manual Input Password", consoante 
as suas preferências.

NOTA: No submenu "PIN Code" a palavra-passe por defeito do utilizador é 345978.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

ATIVAR ANTI PASS BACK

ATIVAR BLOQUEIO INTERNO

01 • Ative a opção "Activate Anti Pass Back".

01 • Ative a opção "Activate Anti Inter Lock".
NOTA: Esta função apenas funciona na MCA-02, com duas portas.

02 • Clique em Configuration > Anti-passback na barra de menus.

03 • Determine as configurações pretendidas.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO
02 • Clique em Configuration > Inter Lock na barra de menus.

03 • Determine as configurações pretendidas.

03 • Determine as configurações pretendidas, cada grupo ao ter dois ou mais utilizadores juntos, poderão 
abrir a porta ao passarem os seus cartões juntos.

ATIVAR ACESSO A DIVERSOS CARTÕES
01 • Ative a opção "Activate MultiCard Access".
02 • Clique em Configuration > Multi-card na barra de menus.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

ATIVAR PRIMEIRO CARTÃO DE ABERTURA
01 • Ative a opção "Activate First Card Open".

04 • Ative a opção "Active" e determine as configurações pretendidas.

02 • Clique em Configuration > First Card na barra de menus.

03 • Escolha o utilizador, e clique "Edit".
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
CONFIGURAÇÃO CONFIGURAÇÃO

ATIVAR LISTA DE TAREFAS DO CONTROLADOR
01 • Ative a opção "Activate First Controller TaskList".

02 • Clique em Configuration > Task List na barra de menus.

03 • Poderá adicionar tarefas, clique "Add" ou editar as tarefas, clique "Edit".

04 • Determine as configurações pretendidas.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
OPERAÇÃO MULTIFUNÇÕES

ATIVAR ABERTURA DA PORTA DE MODO REMOTO ATIVAR REFEIÇÃO
01 • Ative a opção "Activate Remote Open Door". 01 • Ative a opção "Activate Meal".

01 • Clique "Const Meal" na barra de menus.

02 • Clique em Operation > Console na barra de menus.
03 • Primeiro selecione a porta pretendida, e de seguida clique "Remote Open". 
Resultado, a porta selecionada vai abrir.

• CONFIGURAR REFEIÇÃO

• • LEITORES
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02 • Clique "Meal Setup", e de seguida selecione o submenu "Readers". 
03 • Determine as configurações pretendidas.

01 • Clique "Meal Setup", e de seguida selecione o submenu "Rules". 
02 • Determine as configurações pretendidas.

01 • Clique "Meal Setup", e de seguida selecione o submenu "Meal Period". 
02 • Determine as configurações pretendidas.

03 • Poderá ainda fixar a quantidade de consumo, clique "Option" e determine as configurações 
pretendidas.

03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

• • REGRAS

• • PERÍODO DE REFEIÇÃO
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• RELATÓRIO DE REFEIÇÃO

• • RELATÓRIO DE DETALHES DE REFEIÇÃO

• • RELATÓRIO DE ESTADO DE LEITORES • • RELATÓRIO DE ESTADO DE UTILIZADORES

• • RELATÓRIO DE ESTADO DE SUBTOTAL DE DEPARTAMENTO

01 • Clique "Create", e será disposto todos os detalhes de refeição dos utilizadores.

01 • Clique "Create", e selecione "Subtotal of Readers" no submenu, e será disposto todos os tempos de 
refeição e dinheiro por zona.

01 • Clique "Create", e selecione "Statistics" no submenu, e será disposto estatisticamente os tempos e o 
dinheiro total gasto por cada utilizador.

01 • Clique "Create", e selecione "Subtotal of Department" no submenu, e será disposto todos os tempos 
de refeição e dinheiro por departamento.

03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

ATIVAR PATRULHA
01 • Ative a opção "Activate Patrol".

02 • Clique "Patrol" na barra de menus.

• CONFIGURAR PATRULHA

• • PONTO DE PATRULHA

• • REGRAS DE PATRULHA

01 • Clique "Patrol Setup".

02 • Defina a porta para "Patrol Point".

01 • Clique "Patrol Point", e selecione "Patrol Rules" no submenu, e defina as regras atuais.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

• • HOMEM DE PATRULHA

01 • Clique "Patrol Point", e selecione "Patrolman" no submenu, e defina o utilizador que é o homem de 
patrulha.

01 • Clique "Route".

02 • Clique "New" para adicionar uma rota de patrulha.

03 • Determine as configurações pretendidas.

• ROTA DE PATRULHA
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

01 • Clique "Task" e defina o utilizador que fará a rota de patrulha. Não se esqueça de obter registo antes de criar o relatório.
01 • Clique "Create".

02 • Clique "Arange" e de seguida "Ok". 

02 • Clique "Query Option" e defina o filtro que pretende. 
03 • Clique "Query".

• TAREFA DE PATRULHA • RELATÓRIO DE PATRULHA
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

01 • Clique "Statistics".
Resultado, aparecerá as estatisticas do estado do homem de patrulha.

01 • Clique "Address Setup".

01 • Ative a opção "Activate Meeting".

• ESTATÍSTICAS DE PATRULHA • CONFIGURAR MORADA

ATIVAR REUNIÃO
02 • Clique "Add" para configurar a morada da reunião.
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES
03 • Escreva na área "Meeting Address" o nome da reunião, defina a porta, e de seguida clique "Ok".

01 • Clique "Add".

01 • Clique "Stat", aparecerá as estatisticas detalhadas da reunião pretendida. Pode filtrar por "Should", 
"In fact", "Leave", "Absent", "Late", "Total statistical" e "Calculate participants rate".

02 • Adicione a reunião como reunião semanal, "Weekly Meeting", ou outra configuração que pretenda.
03 • Identifique os utilizadores como "Delegate", "Nonvoting Delegate", "Invitational", "Audit", "Employee", 
e "Other".
04 • Caso queira modificar a reunião clique "Edit", se quiser apagar, clique "Delete" na interface principal 

"Meetings".

• ADICIONAR REUNIÃO

• ESTADO DA REUNIÃO
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03.FUNCIONALIDADES EXTENSAS03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES MULTIFUNÇÕES

01 • Clique "Realtime Sign", aparecerá em tempo real que está presente na reunião.

• ENTRADA EM TEMPO REAL • ATIVAR GESTÃO DE OPERADOR

FUNCIONALIDADES

01 • Ative a opção "Activate Operator Management".



35A 35B
PTPT

04. ATENDIMENTO03.FUNCIONALIDADES EXTENSAS
MULTIFUNÇÕES REGRAS NORMAIS DE TURNO
02 • Clique "Tool", e de seguida "Operator Management".

02 • Clique "Attendance", e de seguida "Normal Shift Rules".

03 • Utilize "New", "Edit", "Del", "Edit Privilege", "Groups", e "Zones" para o utilizador.
04 • Clique "Edit Privilege" para atribuir uma operação executiva e o privilégio de função aos utilizadores.
NOTA: "abc" é o administrador de segurança máxima por defeito, não pode utilizar "Del" nem "Edit 
Privilege".

01 • O Sistema tem a função "Attendance" por defeito ativa. Caso queira cancelar essa função, ative a 
opção "Don't Display Attendance".
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04. ATENDIMENTO04. ATENDIMENTO
FÉRIASREGRAS NORMAIS DE TURNO

01 • Clique "Attendance", e de seguida "Holiday".

01 • Clique "Attendance", e de seguida "Leave Business Trip".
FÉRIAS

VIAGEM DE TRABALHO

02 • Determine as configurações pretendidas. 02 • Determine as configurações pretendidas.
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02 • Determine as configurações pretendidas.

04. ATENDIMENTO04. ATENDIMENTO
ENTRADA MANUALVIAGEM DE TRABALHO

01 • Clique "Attendance", e de seguida "Manual Sign". 01 • Clique "Attendance", e de seguida "Attendance Report".

ENTRADA MANUAL RELATÓRIO DE ATENDIMENTO

02 • Determine as configurações pretendidas.



38A 38B
PTPT

05. APÊNDICE04. ATENDIMENTO
CONFIGURAÇÃO DE SERVIDOR SQLRELATÓRIO DE ATENDIMENTO

02 • Clique "Create", e de seguida "Ok".

03 • Clique "Statistics".

01 • Instale o Servidor SQL e depois configure "Access Control SQL Server".
02 • Clique em Operation > Programs > AccessControl > SqlSet.

03 • Clique "Test Conection", e de seguida "Ok".
04 • Clique "Create Database", e de seguida "Ok". A base de dados atual será apagada, e criará uma nova.
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05. APÊNDICE05. APÊNDICE
IMPORTAR INFORMAÇÃO DE CONSUMIDOR POR EXCELCONFIGURAÇÃO DE SERVIDOR SQL

Poderá visualizar a base de dados creada na barra inferior do sistema como "SQL: AccessData".

NOTA: Apenas pode importar informação válida em "ConsumerNO", "Name", "CardID" e "Department".
01 • Clique em Configuration > Personnel > Export to Excel.
02 • Escolha o ficheiro para exportar a informação, de seguida clique Guardar.

05 • Clique em Configuration > Personnel > Import.
06 • Clique "Ok", e de seguida "Ok".

03 • Abra o ficheiro exportado Excel, mencionado na janela de informação.

04 • Se o documento já tiver informação dos utilizadores, poderá apagar se quiser, e crie os novos 
utilizadores. Crie apenas informação "ConsumerNO", "Name", "CardID" e "Department".
NOTA: No Departamento apenas use "\" como separador. Por exemplo: Sales Dep\Oversea Marketing.

IMPORTAR INFORMAÇÃO DE CONSUMIDOR POR EXCEL
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Resultado, a base de dados foi criada.

05. APÊNDICE
IMPORTAR INFORMAÇÃO DE CONSUMIDOR POR EXCEL


